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For Intel Corporation 
Executive summary 
 
Intel Corporation (Intel) commissioned Principled Technologies (PT) to run a set of performance tests on two 
built-to-order Hewlett Packard (HP) PCs with dual-core processors as the systems came out of the box.  The 
goal of the testing was to gauge the performance, using some common industry benchmarks and some 
additional performance tests, that PC buyers would experience on systems they purchased online from such 
well-known sites as www.hpshopping.com.  Intel identified the test systems, tests, test procedures, and test 
settings.  PT purchased and set up the two PCs, and PT executed all tests.  We ran the following benchmarks 
and performance tests: 
 
Industry benchmarks 

• Futuremark PCMark05 1.0.1 – Overall score 
• Futuremark PCMark05 1.0.1 – CPU score 
• BAPCo SYSmark 2004 SE 1.0 
• Futuremark 3DMark05 1.2.0 

 
Digital media performance tests 

• ABBYY FineReader 7.0 Professional Edition performance test 
• Adobe After Effects 6.5 performance test 
• Adobe Photoshop CS2 performance test 
• Adobe Photoshop Elements 3.0 / Adobe Premiere Elements 1.0 performance test 
• LAME 3.97a performance test (open source) 
• Microsoft Windows Media Encoder 9.0 with Advanced Profile performance test 
• Roxio VideoWave 7 Professional performance test 

 
Appendix A provides the cost for both systems, and Appendix B details their configurations.   
 
Whenever possible, we tested each system as it came out of the box.  Only SYSmark 2004 SE would not run 
without specific changes to the system setups.  We note all such changes in the Test Methodology section, 
which also explains in detail how we ran each test. 
 
Figure 1 summarizes the results of the tests, along with basic processor information for each system.  For 
each system we show the median result of three tests.  For all industry benchmarks, higher scores are better.  
For all Digital Media performance tests, lower scores are better, because they represent the time the system 
required to complete each workload.  In the rightmost column we compare the results of the systems.  We 
calculate this comparison by dividing the Intel-based system’s score by the AMD-based system’s score for 
tests in which a higher score is better, and by dividing the AMD-based system’s score by the Intel-based 
system’s score for tests in which a lower score is better.  Consequently, comparative results above 1.00 
indicate tests the Intel-based system won, and those below 1.0 indicate tests the AMD-based system won.  
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Tests HP d4100y HP d4100e  

Processor 
Intel Pentium 
D 840 

AMD Athlon64 
X2 4200+ 

Comp. 
Result 

Industry benchmarks (higher is better) 
Futuremark PCMark05 1.0.1 – Overall score 3510 3268 1.074 
Futuremark PCMark05 1.0.1 – CPU score 5184 4201 1.234 
BAPCo SYSmark 2004 SE – Overall score (1) 203 195 1.041 
Futuremark 3DMark'05 – CPU Tests Overall 5048 4798 1.052 
Digital media performance tests (in seconds; lower is better) 

ABBYY FineReader 7.0 Professional Edition  91 201 2.209 
Adobe After Effects 6.5  449 463 1.031 
Adobe Photoshop CS2 30.376 31.471 1.036 
Adobe Photoshop Elements 3.0 / Premiere Elements 1.0  411 435 1.058 
Lame 3.97a  185 219 1.184 
Microsoft Windows Media Encoder 9.0 with Advanced Profile  77 85 1.104 
Roxio VideoWave 7 Professional  70 75 1.071 

Figure 1:  Results of performance tests on the two systems. 

Notes: 
(1) SYSmark 2004 SE would not run on either system as it came out of the box, so we made the changes to 
each system that the benchmark recommends.  The next section details those changes. 

Test methodology 
 
This section details the methodology we followed in testing the systems. 
 
Configuration differences 
 
When we configured the two systems on www.hpshopping.com, we made them as identical as possible.  We 
could not avoid the following notable differences in the systems: 
 

• The motherboard for the AMD-based d4100e supports only DDR RAM, with the fastest RAM 
available on www.hpshopping.com being DDR-400MHz dual channel SDRAM.  The motherboard for 
the Intel-based d4100y, by contrast, supports DDR2-533MHz SDRAM, which was the only option 
available for our purchase. 

• The hard drive controllers in the systems also differ.  Though both are Serial ATA devices, the AMD-
based d4100e uses ATI SB400 controller, while the Intel-based d4100y uses the Intel 82801GB 
controller. 

• The two systems also have slightly different audio capabilities; more on this below. 
• The prices differ, with the $1,499.99 Intel-based d4100y costing $190 less than the $1,689.99 AMD-

based d4100e.  (These are list prices; HP offered the same rebate on both.)   
 
Appendix A provides complete cost information for both systems, and Appendix B details their configurations.   
 
Differences in audio capabilities 
 
One of the main audio differences between the two systems is the number of speakers their surround-sound 
capabilities support.  The Intel-based system can drive up to eight speakers (7.1 surround sound), while the 
AMD-based system supports up to six (5.1 surround sound).  The additional two speakers the Intel-based 
system can support are side surround units, which would sit between the front and rear speakers on the right 
and left sides. 
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This difference is visible in the analog connections on the systems.  Figure 2 below shows the six mini-plug-
interface analog connections on the Intel-based HP d4100y system.  The blue and pink connections are for 
line-in and microphone input, respectively.  The green connection doubles as a basic two-speaker interface 
and, in a 7.1 configuration, as a front right/left interface.  The black connection handles the rear right/left 
speakers, the gray connection handles the side right/left speakers, and the orange handles the center 
speaker and subwoofer. 
 

 
Figure 2:  Analog audio interface for the Intel-based HP d4100y. 

 
Figure 3 below shows the three mini-plug-interface analog connections for the AMD-based HP d4100e 
system.  Like its Intel-based counterpart, the green doubles as a basic two-speaker interface and, in a 5.1 
configuration, as a front right/left interface.  The blue connection doubles as a line-in input and rear right/left 
speakers, while the pink connection doubles as a microphone input and the center speaker and subwoofer 
connections.  HP pre-installs the software application that configures these audio connections between uses. 
 

 
Figure 3:  Analog audio interface for the AMD-based HP d4100e. 

 
Both systems provide a digital PCM (Pulse Code Modulation) coaxial connection that lets you connect to any 
receiver with a coax audio input.  The PCM signal identifies to the receiver the type of audio signal--such as 
Dolby Digital 2.0 or 5.1, DTS, Pro Logic surround, and so on—that the PC is sending.  The Intel-based 
system came both input and output PCM connections, while the AMD-based system came only with an output 
PCM connection.   
 
We tested the surround sound capabilities of both systems with the following three DVDs, each of which used 
a different audio format: 
 

• DVD movies: 
o The Fifth Element, Superbit Version (Audio format:  Dolby Digital 5.1, DTS 5.1) 
o The Incredibles (Audio format:  Dolby Digital 5.1 EX) 

• DVD audio 
o Queen, A Night at the Opera (Audio format:  DTS 5.1, 96 kHz, 24-bit sampling, Dolby Digital 

2.0) 
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We used a Sony STR-DE598 home theater receiver to accept the digital PCM coaxial connection from both 
systems.   
 
Both systems played the movies without any problems.  When we played the DTS 96 kHz/24-bit DVD-Audio 
disc, however, the AMD-based system had a difficult time communicating with the receiver.  Normally, during 
playback the computer notifies the receiver, through the PCM connection, of the type of decoding format to 
use.  The receiver then displays that format once in its front panel.  When we played the DTS 96 kHz/24-bit 
audio track with the AMD-based system, the receiver flashed DTS 96/24 on the front panel several times 
during playback.  The interruption lasted less than a second, but it occurred approximately every 5 to 15 
seconds.  After a couple of minutes, we found that it was difficult to enjoy the music, and stopped playback. 
 
Initial setup 
 
When the systems arrived, we unpacked and set up each one.  They came with identical keyboards and 
mice.  We did not purchase monitors with the systems, so we used identical monitors from our test stock.  
(The system configuration information in Appendix B provides the standard graphics adapter settings we 
used.)  We then went through the following process with each PC the first time we booted it: 
 

1. Pressed Next to set up Windows XP. 
2. Answered “Yes” to “Do you hear music playing out of the speakers?” 
3. Selected United States, English and U.S. keyboard. 
4. Selected Eastern Time. 
5. Selected “Yes” to both the manufacturer (if present) and Microsoft End User License Agreements. 
6. Selected “No” to automatic updates, because our goal was to test each PC as it came out of the box.   
7. We named each computer with its model and processor vendor (d4100e_AMD and d4100y_INTEL). 
8. We left each machine description blank. 
9. Selected “Skip” during the “How will this computer connect to the Internet?” part of the setup process. 
10. Selected “No” to registering with Microsoft. 
11. Selected “Finish”. 

 
We then used Symantec’s Ghost product to capture an image of the system’s disk over our local network to a 
server.  (To avoid perturbing either system’s disk, we did not make a local Ghost image.)  We then burned 
each Ghost image to a DVD.   
 
Each time we were to run a new benchmark or test on a machine, we used the Ghost image DVD to return 
that machine to the above original, just-set-up image.  We then installed the software necessary to run the 
benchmark or test, made any system changes necessary to let the benchmark or test run, and rebooted.   
 
After we completed each run of a benchmark or test, we rebooted before running the next iteration of that 
benchmark or test. 
 
The following subsections summarize the steps we followed to obtain each of the benchmark or test results in 
this report.   
 
Industry benchmarks 
 
Futuremark PCMark05 Business Edition 
 
We performed the following steps on each PC to make it ready to run this benchmark: 
 

1. Install Windows Media Encoder 9 and Windows Media Player 10, because PCMark05 requires both. 
2. Insert the PCMark05 Business Edition CD into the CD-ROM drive. 
3. Click Next at the InstallShield Wizard dialog box. 
4. Click the “I accept the terms of the license agreement” check box at the License Agreement dialog 

box. 
5. Click Next at the Choose Destination Location dialog box. 
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6. Click Install at the Installation dialog box. 
7. Enter the registration code, and click Next. 
8. Click OK at the Congratulations dialog box. 
9. Click Finish at the Installation Complete dialog box. 

 
We rebooted before each run, and then followed this process to run the test: 
 

1. Start PCMark05. 
2. Under Tests, click Select. 
3. Click Select All to check all tests available. 
4. Click Run PCMark button to run the tests. 

 
 
The benchmark produces, among other results, an overall score and a CPU score; higher scores are better.   
 
BAPCo SYSmark 2004 SE 
 
As we observed in the note below Figure 1, SYSmark 2004 SE would not run successfully on either system 
without some configuration changes to the system.  We made every attempt to run SYSmark 2004 SE in an 
“out-of-box” configuration, but due to conflicts with some applications HP installed on both machines, 
SYSmark either would not install or would suffer fatal errors that cancelled the test run. 
 
The first error we encountered occurred when installing SYSmark 2004 SE.  On both the AMD- and the Intel-
based systems, SYSmark 2004 SE forced us to uninstall Microsoft Office before we could install the 
benchmark.  When we attempted to install the benchmark without uninstalling Microsoft Office, the following 
message box appeared: 
 

 

 
 
Consequently, on both systems we uninstalled Microsoft Office.  We were then able to successfully install the 
benchmark. 
 
Our next problems occurred when we ran the benchmark.  On the Intel-based system, we consistently 
experienced an error during the Internet Content Creation phase of the test that stopped the benchmark:  
SYSmark 2004 SE could not locate a particular script for the Adobe Premiere 6.5 part of its test.  The 
following error message then appeared: 
 

 

Figure 4:  Error message when installing BAPco SYSmark 
2004 SE without first uninstalling Microsoft Office.
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On the AMD-based system, we consistently experienced an error during the Office Productivity phase of the 
test that stopped the benchmark:  The pre-installed Symantec Internet Security and Anti-Virus applications 
wanted to integrate with Outlook 2002 and so stopped the script by requiring user intervention.  The following 
error message then appeared: 
 

 

 
Without human intervention, the benchmark continues to run, this request stands unanswered, and the 
Symantec application then blocks a particular process.  The benchmark then stops running and presents the 
following error message:  
 

  

 
 
Because the benchmark would not run on either system’s out-of-the-box configuration, we then made to each 
system all the changes BAPCo recommends testers make before running the benchmark.  The following list 
summarizes the changes we made to comply with BAPCo’s configuration recommendations: 
 

1. Change the Virtual memory settings:  Right-click My Computer, and choose Properties->Advanced 
tab.  Choose the Settings button under the Performance heading.  Choose the Advanced tab.  Click 
the Change button under the Virtual memory heading.  Select the Custom size radio button.  Set the 
Windows XP Virtual memory size to twice the physical memory size (in this case, 2048 MB).  Click 
OK, and close all My Computer windows. 

2. Uninstall any printers or faxes currently on the system:  Click Start->Control Panel->Printers and 
Other Hardware->View installed printers or fax printers.  Right-click on each installed printer and fax 
printer, and select Delete. 

3. Turn off System Restore:  Right-click My Computer, choose Properties, and click the System Restore 
tab.  Select Turn off System Restore on all drives, and click OK. 

Figure 7:  Second error message that appeared when we ran the benchmark on 
the AMD-based system as it came out of the box (minus Microsoft Office).. 

Figure 6:  First message that appeared when we ran the 
benchmark on the AMD-based system as it came out of the 
box (minus Microsoft Office). 

Figure 5:  SYSmark 2004 SE error message that appeared when we ran the 
benchmark on the Intel-based system as it came out of the box (minus 
Microsoft Office). 
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4. Turn off Automatic Updates:  Right-click My Computer, choose Properties, and click the Automatic 
Updates tab.  Select Turn off Automatic Updates, and click OK. 

5. Uninstall any anti-virus software installed on the machine.  Each of these systems came with 
Symantec Norton Anti-Virus and Internet Security, so we used that product’s uninstall tool to remove 
it. 

6. Disconnect network connections.  
7. Change the video resolution settings:  Right-click anywhere on the Desktop, choose Properties, and 

click o the Settings Tab.  Change video resolution to 1024x768 and 32-bit color. 
 
We then performed the following steps to install the benchmark: 
  

1. Place the SYSmark 2004 SE DVD in the DVD-ROM drive. 
2. Click Next at the SYSmark 2004 SE Setup dialog box. 
3. Accept the license agreement, and click Next. 
4. Fill out the User Name, Company Name, and Serial Number fields in the Customer Information dialog 

box, and click Next. 
5. Click Next at the Destination Directory dialog box. 
6. Click Next at the Select Program Folder dialog box. 
7. Click Yes at the Question dialog box. 
8. Click Finish at the Installation Complete dialog box, and let the system reboot.  

 
We rebooted each time before starting the SYSmark 2004 SE test runs.  We performed the following process 
to run the benchmark: 
 

1. Launch SYSmark 2004 SE. 
2. Click Run on the left-side menu. 
3. Select “Official Run”, choose one iteration, and enter a name for that run. 
4. When the benchmark completes, the main SYSmark 2004 SE menu appears.  Select the Reports 

button, then Official Report, which produces the SYSmark 2004 SE test scores. 
5. At the top, click on Disclosure, and enter all required information (which the benchmark designates 

with an asterisk), and click OK.  When the report appears, click File->Export, and designate a location 
for the Full Disclosure Report. 

 
We initially tried instructing the benchmark to run for three iterations, but it was unable to do so and 
successfully yield an official score, a problem we have encountered frequently with the benchmark.  So, we 
ran three single-iteration tests, recorded each score, and reported the median. 
 
The benchmark produces, among other results, an overall score; higher scores are better.   
 
Futuremark 3DMark05 Business Edition 
 
We performed the following steps on each PC to install the benchmark: 
 

1. Click Next at the Install Shield Wizard dialog box. 
2. Click the “I accept the terms of the license agreement” check box at the License Agreement dialog 

box. 
3. Click Next at the Choose Destination Location dialog box. 
4. Click Install at the Ready to Install the Program dialog box. 
5. Enter Registration Code and click Next to unlock the Business Edition. 
6. Uncheck “View Readme” check box, and click Finish at the Installation Complete dialog box. 

 
We rebooted before each run.  The benchmark includes both Software and Hardware tests.  The process for 
running each test is slightly different. 
 
We followed this process to run the benchmark’s Software test: 
 



Principled Technologies, Inc.:  Dual-Core PC Performance:  Built-To-Order Systems  8 
 

1. Start 3DMark05. 
2. Under Tip of the Day, check Do not show this dialog again, and click Close. 
3. Under the Tests section, click Select. 
4. Click Select All so that all tests will run, and click OK. 
5. Under the Settings section, click Change. 
6. Make sure the resolution matches the current settings in Windows (1024 x 768). 
7. Check Force software vertex shaders, and click OK. 
8. Click the Run 3DMark button to run the tests. 

 
We followed this process to run the benchmark’s Hardware test: 
 

1. Start 3DMark05. 
2. Under Tip of the Day, check Do not show this dialog again, and click Close. 
3. Under the Tests section, click Select. 
4. Click Select All so that all tests will run, and click OK. 
5. Under the Settings section, click Change. 
6. Make sure the resolution matches the current settings in Windows (1024 x 768). 
7. Click the Run 3DMark button to run the tests. 

 
The benchmark produces, among other results, an overall score; higher scores are better. 
 
Digital media performance tests 
 
ABBYY FineReader 7.0 Professional Edition performance test 
 
We used this application to test how quickly each system completed the task of batch scanning a PDF 
document using OCR (Optical Character Recognition) technology and producing an editable text document.   
 
Intel provided the PDF document we used in this test.  This document has the following key characteristics: 
 

• Size:  789KB (808,130 bytes) 
• Number of pages:  46  

 
We performed the following steps to prepare each system for this test: 
 

1. Download an evaluation copy of ABBYY FineReader 7.0 Professional Edition from 
http://download.abbyy.com/content/default.aspx. 

2. Double-click on the installation executable file. 
3. On the self-extractor screen accept the temporary destination folder, and click Install. 
4. Accept the License Agreement, and click Next. 
5. Choose the Typical installation, and click Next. 
6. Select No to disable the ABBYY Community news channel, and click Next. 
7. Click Install to start the installation process. 
8. At the Installation completed screen, click Finish. 
9. Reboot the system. 

 
We performed the following steps to run this test: 
 

1. Start ABBYY FineReader 7.0 by clicking Start->All Programs->ABBYY FineReader 7.0->ABBYY 
FineReader 7.0 Professional Edition. 

2. At the Try&Buy message box, select Continue working with Try&Buy program, and click OK. 
3. When the following Welcome dialog appears, uncheck the box next to “Show Welcome dialog at 

startup”, and click Close. 
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4. In the main window, click the pull-down menu View, select Batch View, and then select Details. A 
screen like the one below will appear. 

 

 
 

5. Click the File pull-down menu, and select Open Image.  Navigate to the PDF document, and click 
Open.  The image just before the open will appear like the example below. 
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6. A progress bar like the one below will appear and show the status of the program as it loads the PDF 
document. 

 

 
 

7. Once the program has finished loading the document, the main window, which should look like the 
example below, will show the first page of the document and a list of the pages within the document. 

 

 
 

8. Click the Process pull-down menu, then select Start Background Recognition, and start the stopwatch 
simultaneously. 
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9. In the third column of the Batch section (center of the main window), an icon ( ) will appear after 
each page number when ABBYY FineReader 7.0 has scanned and read that page.  When the batch 
process has completed, all 46 pages will appear with that icon next to them.  When the icon appears 
next to the final page, page 46, as in the example below, stop the stopwatch. 

 

 
 

10. Record this time. 
11. Reboot the system. 

 
Lower times to complete the task are better. 
 
Adobe After Effects 6.5 
 
We used this application to test how quickly each system completed the task of processing a pre-existing 
Adobe After Effects file and rendering the output motion graphics. 
 
Intel provided the Adobe After Effects project .ae6 file and all supporting data files, which we stored on the C:\ 
drive in the directory “AE6_workload”. 
 
We performed the following steps to prepare each system to run this test: 
 

1. Install QuickTime 6.5, because After Effects 6.5 requires it. 
2. Install After Effects by double-clicking on the executable setup file. 
3. Select English (United States) as the primary language for installation. 
4. Click Next at the Welcome screen. 
5. Select US English as the primary language for running the program. 
6. Accept the terms in the license agreement, and click Next. 
7. Entered User Name, Organization, and Serial Number, and click Next. 
8. Select Complete installation, and click Next 
9. Use the default installation folder, and click Install. 
10. Click Finish.  The automated portion of the installation is complete. 
11. Copy the AE6_Workload folder from the CD to the C:\ drive. 
12. Reboot the system. 

 
We performed the following steps to run this test: 
 

1. Start After Effects by clicking Start->All Programs->Adobe After Effects 6.5. 
2. Uncheck the Show Tips at Startup box, and click OK. 
3. Click File, and select Open Project, as in the example below. 
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4. Navigate to the C:\AE6_workload folder, highlight the test_all_AE6_default.aep file, and click OK, as 
in the example below. 

 

 
 

5. At the message box stating the project must be converted from version 6.0, click OK. 
6. At the message box stating the project contains six references to missing effects, click OK. 
7. In the Render Queue box, which will look like the example below, click Render at the top right corner. 

 

 



Principled Technologies, Inc.:  Dual-Core PC Performance:  Built-To-Order Systems  13 
 

 
8. Eight messages boxes will appear stating various footage files the program requires to render the 

composition.  Click OK at each one. 
9. After rendering completes, exit After Effects.  At the prompt to save the project, click No. 
10. Open Windows Explorer, and navigate to the C:\Program Files\Adobe\After Effects 6.5\Support 

Files\AE Project Logs folder. 
11. Open the newly created log file.  Each log file name contains the date and time when the rendering 

completed, making it easy to locate the correct log file for each test run. 
12. At the bottom of the text file, right after “Total Time Elapsed”, is the total time the system needed to 

complete the rendering project.  Record this time. 
13. Delete all the files in the C:\AE6_workload\Output directory 
14. Reboot the system. 

 
A lower time to complete the project is better. 
 
Adobe Photoshop CS2 
 
Intel provided both the Adobe Photoshop CS2 .psp file and the .tif file (Country Road.tif) this test uses.  We 
stored these two files in a directory on the c:\ drive named “photoshopTest”. 
 
Intel also provided the Rational Visual Test 6.5 client installation and the IBM Visual Test 6.5 script 
(Photoshop_Filters.pc6) files that compose this test.  We stored the Rational Visual Test installation 
executable file in the “photoshopTest” folder and the IBM Visual Test script file on the Desktop. 
 
We had to install both Adobe Photoshop CS2 and the IBM Visual Test runtime for this test. 
 
We performed the following steps to install Adobe Photoshop CS2 on each system: 
 

1. Insert the Adobe Photoshop CS2 CD into the CD-ROM drive. 
2. Select North American English for the installation process, and Click OK. 
3. Click Accept at the License Agreement screen. 
4. Click Install Adobe Photoshop CS2. 
5. At the Welcome screen, click Next. 
6. At the License Agreement screen, select English at the top, and click Accept. 
7. At the Customer Information screen, enter the User Name, Organization, and Serial Number. 
8. Accept the default installation folder, and click Next. 
9. Accept the default file types to associate with Photoshop CS2, and click Next. 
10. Click Install to start the installation process. 
11. At the Activate Adobe Photoshop screen, click the radio button next to Remind me, select “in 5 days”, 

and click Next. 
12. Click Next again at the Activate Later screen. 
13. Uncheck the box next to Show the readme file, and click Finish at the installation complete screen. 
14. Reboot the system. 
15. When the system is ready, start Adobe Photoshop CS2 by clicking Start->All Programs->Adobe 

Photoshop CS2. 
16. At the Welcome Screen, uncheck the box next to the Show this dialog at startup, and click Close. 
17. At the Adobe Updater Preferences screen, uncheck the box next to Automatically check for updates 

every month, and click OK. 
18. Reboot the system. 

 
We performed the following steps to install the IBM Visual Test 6.5 runtime on each system: 
 

1. Open Windows Explorer, and navigate to the folder containing the Visual Test 6.5 client 
installation executable. 

2. Double-click on the executable file. 
3. At the Welcome screen, click Next. 
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4. Accept the default installation folder, and click Next. 
5. After the installation completes, click Finish. 

 
The Visual Test script for this performance test cannot locate the .tif file it requires (Country Road.tif) unless 
Microsoft Windows XP is not hiding known file types.  Use the following process to make sure it is not set to 
hide known file types: 
 

1. Right click on My Computer, and select Explore. 
2. Click the Tools pull-down menu, and select Folder Options. 
3. Click the View tab. 
4. Uncheck the box next to Hide extension for known file types. 
5. Click Apply. 
6. Click Apply to All Folders at the top. 
7. Click OK. 
8. Reboot the system. 

 
We performed the following steps to run the Adobe Photoshop CS2 performance test: 
 

1. Double-click the Photoshop_Filters.pc6 file on the desktop. 
2. Microsoft Windows XP opens a dialog box asking which application to use in association with the .pc6 

extension. 
3. Click "Select program from list", and click OK. 
4. Click the Browse button, and navigate to the C:\Program Files\VT_Run\.folder. 
5. Select Mtrun.exe, and click Open. 
6. The Adobe Photoshop CS2 test script will then start. 
7. The script completes when Adobe Photoshop CS2 closes. 
8. Open Windows Explorer, navigate to the C:\photoshopTest\results directory, and open the _temp.txt 

file with Notepad. 
9. The text file only contains one line.  The number after “Run time” on that line is the amount of time, in 

milliseconds, the script ran.  Divide this number by 1,000 to get the number of seconds the script ran, 
and record that time. 

10. Reboot the system. 
 
Lower times to complete the task are better. 
 
Adobe Photoshop Elements 3.0 with Premiere Elements 1.0 
 
We used these applications to measure how quickly each system could create a slide show containing 30 
image files, convert the slide show into a movie, and burn it to a DVD.   
 
Intel provided the 30 image files (as .jpg files) and the MP3 file this performance test uses.  The 30 image files 
had the following key characteristics: 
 

• Resolution:  2592W x 1944H (180 dpi horizontal x 180 dpi vertical) 
• Size:  from 369KB (377,000 bytes) to 2,667KB (2,730,944 bytes) 
• Bit depth:  24-bit color 

 
The MP3 file had the following key characteristics: 
 

• Length (mm:ss):  2:52 
• Bit Rate:  160kbps 
• Channels:  2 (stereo) 
• Audio sample rate:  44 kHz 

 
We had to install both Adobe Photoshop Elements 3.0 and Adobe Premiere Elements 1.0 to run this test. 
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We performed the following steps on each PC to install Photoshop Elements 3.0: 
 

1. Insert the Adobe Photoshop Elements 3.0 CD into the CD-ROM drive. 
2. Select English for the installation process, and Click OK. 
3. Click Accept at the License Agreement screen. 
4. Click Install Adobe Photoshop Elements 3.0. 
5. At the Welcome screen, click Next. 
6. At the Select EULA Language screen, select US English, and click Next. 
7. Click Accept at the License Agreement screen. 
8. At the Customer Information screen, enter the User Name, Organization, and Serial Number. 
9. Accept the default installation folder, and click Next. 
10. Accept the default file types to associate with Photoshop Elements, and click Next. 
11. Click Install to start the installation process. 
12. Click Finish at the installation complete screen. 

 
We performed the following steps on each PC to install Premier Elements 1.0 
 

1. Insert the Adobe Premier Elements 1.0 CD into the CD-ROM drive. 
2. Select English for the installation process, and Click OK. 
3. Click Accept at the License Agreement screen. 
4. Click Install Adobe Premier Elements 1.0. 
5. At the Welcome screen, click Next. 
6. At the Select EULA Language screen, select US English, and click Next. 
7. Click Accept at the License Agreement screen. 
8. At the Customer Information screen, enter the User Name, Organization, and Serial Number. 
9. Accept the default installation folder, and click Next. 
10. Click Install to start the installation process. 
11. Insert Disk 2 (the second CD) when the installation program requests it. 
12. Click Finish at the installation complete screen. 
13. Reboot the system. 

 
We then performed the following steps to run the performance test: 
 

1. Launch Photoshop Elements.  A startup screen like the one below should appear. 
 

 
 

2. Select and click the fifth icon from the left, Make Photo Creation.  A window like the one below should 
appear. 
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3. Click creation type Slide Show (blue above) to create a slide show.  A window like the one below 

should appear. 
 

 
 
4. Choose the Custom Slide Show creation type (blue above).  The following window should appear. 
 

 
 

5. Click Yes to set up the Organizer.  A window like the one below will appear. 
 



Principled Technologies, Inc.:  Dual-Core PC Performance:  Built-To-Order Systems  17 
 

 
 

6. Navigate to the location of the test photos, and select all of them, as in the example window.  Click 
the Get Photos button. 

7. A main window like the one below will appear and show all the selected photos. 
 

 
 

8. Select all of the photos, and click Create.  A Slide Show editor window like the one below will appear.   
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9. Click the first slide at the bottom of the screen, and change the time delay to two seconds.   
10. Click the same slide again, and apply the two-second delay to all slides. 
11. Click the slide transition special effect icon that separates the first two slides.   
12. Choose the “fade” effect.   
13. Click the “fade”’ icon, and apply the same effect to all slide transitions.  
14. At the bottom, click on the button “Click Here to Add Audio to your Slideshow”.  A window like the one 

below will appear. 
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15. Navigate to the folder that contains the .mp3 test file (background.mp3), and click Open. 
16. From the File pull-down menu at the top, select Save to save the slideshow.  A dialog box like the one 

below will appear.  Name the slideshow “outdoors”, and click Save. 
 

  
 

17. The Catalog screen (example below) will reappear with the newly created slideshow in the top left 
corner.   

 

 
 

18. Highlight the new slide show, and click the Create button.  The following dialog box will appear. 
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19. Click “DVD with Menu” (blue above).  A screen like the one below will appear. 
 

 
 
20. The application will now create the Windows Media Video file that holds the DVD creation.  Click 

Next, and navigate to the folder containing the video file. 
21. While the application is creating the file, a progress dialog like the one below will appear. 
 

 
 
22. Using Windows Explorer, navigate to the newly created outdoors.wmv file, and select Properties. 
23. In the center of the Properties dialog, locate the Created and Modified times of the file. 
24. Subtract the Created time from the Modified time.  The difference represents the time the application 

required to create the slide-show video .wmv file.  Record this time. 
25. When Adobe Photoshop Elements finishes creating the .wmv file, Adobe Premiere Elements 

automatically launches and displays a dialog like the one below.  
 

 
 

26. Click OK to create the default project.  A window like the one below will appear.   
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27. Click Apply a Template for a DVD with Menus, and select the top template.  Click OK.  The following 

dialog box will appear. 
 

 
 

28. Click No.  The following DVD Layout window will appear. 
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29. Click the Export button at the top right corner to export the file to a DVD.  A Burn DVD dialog like the 
one below will appear. 

  

 
 

30. Select the radio button next to Folder to burn the files to a folder.  Accept the default file location. 
31. Click Burn, and simultaneously start a stopwatch.  A progress dialog like the one below will appear. 
 

 
 

32. When the application has finished burning the DVD file to a folder, click the stopwatch, and record the 
time the application took to create the DVD file.   

33. The result for this test is the sum of the time the first application took to create the .wmv file and the 
time the second took to create the DVD folder. 

34. Reboot the system. 
 
Lower times to complete both tasks are better. 
 
LAME 3.97 
 
LAME 3.97 does not require any installation process.   
 
Intel supplied the .wav file for this performance test.  That file has the following key characteristics: 
 

• Length (mm:ss):  69:29 
• Bit Rate:  1411kbps 
• Channels:  2 (stereo) 
• Audio sample rate:  44 kHz 
• Size:  701 MB (735,557,138 bytes) 

 
We performed the following steps to prepare each system for this test: 
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1. Create a new directory named “lame” in C:\. 
2. Download the LAME binary, lame.3.97a.icl-mt.exe, from http://softlab.technion.ac.il/project/LAME/bin/ 

and store it in the C:\lame directory. 
3. Copy the mixtest.wav file into the same directory. 
 

The LAME application cannot locate the .wav file it requires (mixtest.wav) unless Microsoft Windows XP is not 
hiding known file types.  Use the following process to make sure it is not set to hide known file types: 
 
 

1. Right click on My Computer, and select Explore. 
2. Click the Tools pull-down menu, and select Folder Options. 
3. Click the View tab. 
4. Uncheck the box next to Hide extension for known file types. 
5. Click Apply. 
6. Click Apply to All Folders at the top. 
7. Click OK. 
8. Reboot the system. 

 
We performed the following steps to run this test: 
 

1. Open a command prompt by clicking Start->Run->, typing “cmd” in the prompt, and clicking OK. 
2. Navigate to the C:\lame directory by typing “cd c:\lame”. 
3. In this directory, type the following command line.  (The –nores and –mt flags instruct LAME to use 

the multi-threaded encoder.  The default constant bit rate for LAME is 128kbps.) The window should 
then resemble the example below. 

 
lame.3.97a.icl-mt.exe -nores -mt mixtest.wav.   
 

 
 
4. Press Enter. 
5. LAME will provide a time counter indicating the time remaining until completion. 
6. When it completes, the command prompt window will look like the example below.  
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7. Locate the time listed under the heading “REAL time/estim”.  It is how long the application took to 
perform the task.  Record this time. 

8. Delete the output file in the C:\lame directory. 
9. Reboot the system. 

 
Lower times to complete the task are better. 
 
Microsoft Windows Media Encoder 9.0 
 
The Microsoft Windows Media Encoder 9.0 performance test measures how quickly each system converts a 
.avi file into a Microsoft Windows Media Video 9.0 streaming media file. 
 
Intel provided the file, kitesurfing.avi, this test used.  The file has the following key characteristics: 
 

• Length (mm:ss):  2:01 
• Size:  416 MB (436,644,352 bytes) 
• Video resolution:  720x480 

 
We stored this file in the My Videos directory.   
 
We performed the following steps to prepare each system for this test: 
 

1. Download Microsoft Media Player 10 from Microsoft’s Web site 
(http://www.microsoft.com/windows/windowsmedia/mp10/default.aspx), and use this executable to 
upgrade the installed player from version 9 to version 10, which the test requires. 

2. Reboot the system. 
3. Download Microsoft Windows Media Encoder 9.0 from Microsoft’s Web site 

(http://www.microsoft.com/windows/windowsmedia/9series/encoder/default.aspx), and store this file 
in the C:\ directory. 

4. Using Windows Explorer, navigate to the downloaded Microsoft Windows Media Encoder 9.0 
installation executable file, and double-click it. 

5. At the Welcome screen, click Next. 
6. Accept the License Agreement, and click Next. 
7. Accept the default installation folder, and click Next. 
8. Click Install to begin the installation process. 
9. When the installation completes, click Finish. 
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10. From the Desktop, double-click the Windows Media Player 10 icon. 
11. At the License Agreement screen, click I Accept. 
12. At the Confirm software download license agreement screen, click I Accept. 
13. At the Welcome screen, click Next. 
14. At the Select Your Privacy Options, accept all default settings, and click Next. 
15. Accept all default file associations, and click Finish. 
16. Reboot the system. 

 
We performed the following steps to run the Microsoft Windows Media Encoder 9.0 performance test: 
 

1. Start Windows Media Encoder 9 by clicking Start->Programs->Windows Media->Windows Media 
Encoder.  A New Session window like the one below will appear. 

 

 
 

2. Highlight Custom Session, and click OK.  A window like the one below will appear. 
 

 
 

3. In the Sources tab, click the Browse button, navigate to the My Videos directory, highlight the 
kitesurfing.avi file, and click OK.   

4. Click the Output tab.  A window like the one below will appear. 
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5. Uncheck the box next to Pull from encoder in the center of the screen.  Check the box next to Encode 

to file towards the bottom of the screen. 
6. Click the Compression tab.  A window like the one below will appear. 
 

 
 
7. Click Edit… towards the top right corner of the window.  The Custom Encoding Settings dialog will 

open and show a window like the one below.   
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8. In the Media Types section, select Windows Media Video 9 Advanced Profile next to Video.  Click 

OK. 
9. Click the Compression tab, then click Apply.  A dialog like the one below will appear stating that the 

output file has been renamed with a new extension. 
 

 
 
10. Click OK. 
11. The main window will appear and look like the example below.   

 

 
 

12. Click the green Start Encoding button at the top of the screen.  A screen like the one below will 



Principled Technologies, Inc.:  Dual-Core PC Performance:  Built-To-Order Systems  28 
 

appear.  The green progress bar at the bottom right of the screen will show the status of the encoding 
process. 

 

 
 

13. When the encoding process completes, an Encoding Results window like the one below will appear. 
 

 
 

14. The fifth line shows the Session Duration, which is the time the application took to complete the 
conversion.  Record this time as the test’s result.   

15. Click Close.  A window like the one below will appear. 
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16. Click No. 
17. Using Windows Explorer, find and delete the output.wmv file. 
18. Reboot the system. 

 
Lower times to complete the task are better. 
 
Roxio VideoWave 7 Professional 
 
This test measures how quickly each system converts a .avi file into a Microsoft .wmv file using Roxio 
VideoWave 7 Professional. 
 
Intel provided the file, kitesurfing.avi, this test used.  The file has the following key characteristics: 
 

• Length (mm:ss):  2:01 
• Size:  416 MB (436,644,352 bytes) 
• Video resolution:  720x480 

 
We stored this file in the My Videos directory.   
 
We performed the following steps to prepare each system for this test: 
 

1. Insert the Roxio VideoWave 7 Professional CD into the CD-ROM drive. 
2. At the Welcome screen, click Next. 
3. Accept the license agreement, and click Next. 
4. Enter the User Name, Organization, and CD key.  Click Next. 
5. Choose Complete for the Setup Type, and click Next. 
6. Click Install to start the installation process. 
7. When prompted, replace the CD in the CD-ROM drive with the VideoWave 7 Content CD, and click 

OK. 
8. At the installation complete screen, click Finish. 
9. When prompted, click Yes to reboot the system. 

 
We performed the following steps to run this test: 
 

1. Start Roxio VideoWave 7 Professional by double-clicking its icon on the Desktop.  A main window like 
the one below will appear. 
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2. Click Edit Video, which is under the Edit category at the top of the window.  An editing window like the 
one below will appear. 

 

 
 

3. Under Media Selector – Folders, navigate to the My Videos directory, and highlight kitesurfing.avi.   
4. Drag kitesurfing.avi to Box 1 in the Production Editor – Storyline section at the bottom of the screen.  

The window will now resemble the following example. 
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5. Click the File pull-down menu, and select Output Production To….  The upper left of the window will 
resemble the example below. 

 

 
 

6. A Save Production dialog like the one below will appear. 
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7. Click No.   
8. A production window like the one below will appear.  Select Video File for the destination of the 

output, as in the example below, and click Next. 
 

 
 

9. A window like the one below will appear.  Click Publish to Web under the Purpose heading, and 
select Best under the Quality heading, as in this example.  Click Next. 
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10. A window like the one below will appear.  Enter the name of the output file, as in this example, then 
click Next. 

 

 
 

11. A window like the example below will appear.  Click the Render file button. 
 

 
 

12. The window will resemble the example below, with a progress bar indicating the status of the 
encoding process. 
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13. When the application has finished encoding the file, a message in the center of the screen will read 
“Video complete!”, as in the example below. 

 

 
 

14. Exit Roxio VideoWave 7 Professional. 
15. Using Windows Explorer, navigate to the My Videos directory, right-click the kitesurfing.wmv file, and 

select Properties. 
16. In the center of the Properties dialog, locate the Created and Modified times of the file. 
17. Subtract the Created time from the Modified time.  The difference represents the time the application 

required to encode the .avi file into the .wmv format.  Record this time as the result of the test. 
18. Delete the kitesurfing.wmv file. 
19.  Reboot the system. 

 
Lower times to complete the task are better. 
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Appendix A:  Test system price and purchase information 
 
We purchased the two HP built-to-order systems on July 19, 2005 via www.hpshopping.com.   
 
Figure 6 below presents the SKU and price information for the two PCs. 
 
System HP d4100y system HP d4100e system 
Processor Intel Pentium D 840 AMD Athlon64 X2 4200+ 
Processor frequency (GHz) 3.2 2.2
Part number PX181AV#ABA PU061AV#ABA
Unit price ($) 1,499.99 1,689.99
Tax ($) (1) 0.00 0.00
Shipping ($) (1) 0.00 0.00
Total we paid ($) 1,499.99 1,689.99
HP PC Mail-In Rebate ($) 150.00 150.00
Effective price after rebate ($) 1,349.99 1,539.99

Figure 8:  Purchase information for the two HP Media Center PCs. 

Notes: 
(1) www.hpshopping.com did not add any tax or shipping charges. 
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Appendix B:  Test system configuration information 
 
This appendix provides detailed configuration information about the two test systems.   
 
System HP d4100y PC HP d4100e PC 
General 
Processor and OS kernel: (physical, 
core, logical) / (UP, MP) 

1P2C2L / MP 1P2C2L / MP 

Number of physical processors 1 1 
Single/Dual Core processors Dual core Dual core 
Processor HT Status N/A N/A 
System Power Management Policy 
(AC/AlwaysOn, AC/Adaptive, 
DC/AlwaysOn, DC/Adaptive, Other) 

AC / AlwaysOn AC / AlwaysOn 

CPU 
Segment (S=Server, D=Desktop, 
M=Mobile) 

D D 

Vendor Intel AMD 
Name Pentium D Athlon64 
Model number Pentium D 840 Athlon64 X2 4200+ 
Stepping A0 E6 
Socket type and number of pins LGA775 Socket 939 
Core frequency 3200 2200 
Front-side bus frequency 800 HyperTransport 1000MHz 
L1 Cache 16K+12K 64KB + 64KB 
L2 Cache 2x1MB 2x512KB 
Platform 
Vendor ASUSTek Computer ASUSTek Computer 
Motherboard model number P5LP-LE A8AE-LE 
Motherboard chipset Intel 945P ATI RS480/RX480 
Motherboard revision number N/A N/A 
System/motherboard serial number MXG52912VD / 

0011D800003EC93E 
MXG53005XV / C57S006 

Bios name and version Phoenix Technologies version: 
3.02, 05/05/2005 

Phoenix Technologies version: 
3.06, 07/19/2005 

BIOS settings Setup default Setup default 
Chipset INF driver  Not available because the 

vendor installed the drivers 
Not available because the 
vendor installed the drivers 

Memory module(s) 
Vendor and model number Samsung M3 78T6553BZ0-CD5 Hyundai Electronics HYMD264 

646DP8JD43 
Type PC4300 DDR2-SDRAM PC3200 DDR-SDRAM 
Speed (MHz) 533 400 
Speed running in the system (MHz) 266 200 
Timing/Latency (tCL-tRCD-tRP-
tRASmin) 

4-4-4-11 3-3-3-8 

Size 1024 MB 1024 MB 
Number of sticks 2 x 512 MB 2 x 512 MB 
Chip organization (Single-sided, 
Double-sided) 

Single-sided Double-sided 

Channel (Single/Dual) Dual Dual 
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Hard disk 
Vendor and model number Seagate ST380013AS Seagate ST380013AS 
Size 80 GB 80 GB 
Buffer Size 8 MB 8 MB 
RPM 7,200 7,200 
Type Serial ATA 1.5 Serial ATA 1.5 
Controller Intel 82801GB (ICH7) Serial ATA 

Storage Controller 
ATI SB400 Serial ATA Controller 

Driver Intel version 7.0.0.1014 Microsoft version 5.1.2600.2180 
Operating system 
Name Windows XP Home Edition Windows XP Home Edition 
Build number 2600 2600 
Service pack SP2 SP2 
File system NTFS NTFS 
Kernel ACPI Multiprocessor PC ACPI Multiprocessor PC 
Language English English 
Microsoft DirectX version DirectX 9.0c DirectX 9.0c 
Graphics 
Vendor and model number ATI RADEON X300 ATI RADEON X300 
Chipset RADEON X300 SE (0x5860) RADEON X300 SE (0x5860) 
Chipset codename RV370 RV370 
BIOS version 113-AA14000-103 113-AA14000-103 
Type (P=PCI Express, A=AGP 8X, 
I=Integrated) 

P P 

Memory size 128 MB 128 MB 
Resolution 1024 x 768 x 32-bit color 1024 x 768 x 32-bit color 
Driver ATI Technologies version:  

6.14.10.6512 
ATI Technologies version:  
6.14.10.6512 

Sound card/subsystem 
Vendor and model number Realtek High Definition Audio Realtek AC’97 Audio 
Type (P=PCI, I=Integrated) I I 
Driver Realtek version 5.10.0.5123 Realtek version 5.10.0.5840 
Network card/subsystem 
Vendor and model number Intel PRO/100 VE Realtek RTL8139/810x Family 

Faster Ethernet NIC 
Type (P=PCI, I=Integrated) I I 
Driver Intel version 8.0.15.0 Realtek version 5.505.1004.2002 
Optical drive(s) 
Vendor and model number Samsung SD-616E Philips DROM6216 
Type (CDROM, CDRW, DVD-ROM, 
DVD-W) 

DVD-ROM 16x DVD-ROM 16x 

Interface (I=Internal, E=External) I I 
USB ports 
Number 8 (4 front, 4 back) 6 (2 front, 4 back) 
Type 2.0 2.0 
Monitor 
CRT/LCD type (P=Plug & Play, 
T=TFT, R=Reflective) 

CRT / P CRT/ P 

CRT/LCD refresh rate 75Hz 75Hz 
Other information Mag Innovision Model 786N Mag Innovision Model 786N 

Figure 9:  System configuration information for both test systems. 
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